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INTRODUCTION 

This User Guide is designed to serve as a brief overview to help you get started. There is also 
information available under the Help option in the various Contributor interface toolbar. If necessary 
you can access the Help by launching the Contributor interface from the System Tray and selecting Help 
> Help and Support. 

If you would like further instructions, please consult the Features list at 
http://support.colligo.com/Lists/Features/AllItems.aspx where you will find a complete list of features 
by product along with instructions for use. You will also find a number of screencasts on the support site 
that walk you through the main product features. The SharePoint support site can be synchronized with 
Colligo Contributor for anytime access, online or offline. Please follow the instructions on the home 
page at http://www.colligo.com/support/. 

Please send questions and feedback to support@colligo.com. 

  

http://support.colligo.com/Lists/Features/AllItems.aspx
http://www.colligo.com/resources/screencasts/
http://www.colligo.com/support/
mailto:support@colligo.com
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TECHNICAL REQUIREMENTS  

Systems Supported 

 Microsoft® Windows® 7 Home Premium; Professional or Ultimate 

 Microsoft® Windows® Vista Business; Enterprise or Ultimate 

 Microsoft® Windows® XP Home or Professional 

 Microsoft Office 2003 – 2010 (Office 2003 SP2 or later for InfoPath forms) 

 Internet Explorer 6.0 or later 

 SharePoint Server 2010, MOSS 2007 and SPS 2003; SharePoint Foundation and WSS (2.0 or 3.0); 
SharePoint 2010 Online (Office365) and BPOS 

 Consumes roughly 20MB of disk space, not including content 

 If you are running a previous version, the new version can be installed over top of the old version 
without an uninstall. This also preserves all of the cached content.  

Application Prerequisites 

 Microsoft® .NET framework 3.5 Runtime 

Outlook Add-in Prerequisites 

 Compatible version of Outlook (Outlook 2010, 2007 or 2003) 

 Office 2003 or Office 2007 Primary Interop Assemblies (depending on which version of Office is 
installed) 

 Microsoft Visual Studio 2005 Tools for Office Second Edition (VSTO 2005 SE) Runtime 

 Microsoft Visual C++ 2008 SP1 Redistributable Package 
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INSTALLING COLLIGO CONTRIBUTOR 

Colligo provides both an .exe installer and an .msi installer for Contributor.  

There are different installer packages dependent on which version of Office you have installed: 

 For 32-bit Office, use the x86 installer 

 For 64-bit Office, use the x64 installer 

EXE Installer 

This installer package is an executable file with the following key features: 

 Supports interactive install only (does not support silent install) 

 Automatically installs software prerequisites (downloaded from www.colligo.com) 

 Not customizable 

Interactive EXE Install 

NOTE: Microsoft Outlook must be closed for the installation to be successful.  
1. Double-click the installation file.  
2. Prerequisites are downloaded and installed. 
3. Enter your license key. 

Colligo Contributor can be set to launch at Windows Start Up. This enables the background 
synchronization to start automatically.  

MSI Installer 

The MSI installer package has the following key features: 

 Supports silent and interactive installs 

 Does not install prerequisites - these must be downloaded and pre-installed 

 Customizable 

Interactive MSI Install 

NOTE: Microsoft Outlook must be closed for the installation to be successful. 
1. Ensure prerequisites are installed. 
2. Double-click the installation file.  
3. Enter your license key. 

Terminal Server Install 

For information on installing in a Terminal Server environment, see the Colligo Contributor Terminal 
Server User Guide.  

Concurrent version installations 

Colligo does not support side-by-side installations, running multiple versions or different versions of 
Contributor.  

Version reversion/downgrading 

It is not possible to revert to an earlier version of Contributor after upgrading as the database is often 
updated.  
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OUTLOOK UPLOADER 

Adding a Site to Uploader 

It is possible to add a site to Contributor in a number of ways, including: 

 Use the Connect to Contributor option in Internet Explorer 

 Site > Download Site menu option 

 Click the site selector drop-down and select Download Site… 

 Drag-and-drop a URL from Internet Explorer Into Contributor 

Internet Explorer Toolbar Connect to Outlook Button 

1. Navigate to a SharePoint List or Library in Internet Explorer. 
2. Click the yellow Connect to Outlook icon on the toolbar. 

 

Outlook launches, if it is not already running, and displays a dialog asking for confirmation that you 
wish to connect the library to Outlook. 

 

Outlook Uploader does not support caching. However, for an explanation of the difference between 
Online and Cached, see Cached vs. Online Modes. 

You may be prompted for credentials to connect to the SharePoint site. Use your default Windows 
credentials, or supply other specific credentials. 

 

If the site you are connecting to is an Office365 site, you are prompted for your Office365 credentials as 
follows: 
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If the Connect to Outlook process starts on a page that does not relate to a SharePoint List, the 
following message displays:  

 

3. Click OK, then navigate to a list in Internet Explorer and click Connect to Outlook again. 

Once Contributor has finished downloading the List definitions, the folders display in Outlook. 
Contributor builds out a tree for the subfolders of the selected document library. 

The Online view displays as follows: 
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Cached vs. Online Modes 

Contributor Uploader only supports the Online mode; it does not support cached. 

Online Mode 

Key functionality of Contributor Uploader operating in Online Mode is: 

 Does not maintain a cache of data  

 Uploads content to SharePoint with metadata Prompt 

 View the SharePoint site in Outlook 

 Navigate through SharePoint site using Outlook folder tree 

 Automatically extract Email metadata (To, From, Sent, Subject, etc) 

Cached Mode 

Key additional functionality of Contributor operating in Cached Mode is: 

 Content is cached providing offline access 

 Local access and edit of existing SharePoint content including metadata. 
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INTEGRATED BROWSER INTERFACE 

If you click on an Outlook folder under the Colligo for SharePoint area, a browser displays the selected 
SharePoint location. 
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UPLOADING CONTENT 

Using Drag-and-Drop 

You can upload emails to SharePoint by dragging-and-dropping directly from your inbox into the 
Outlook folder tree. Contributor automatically extracts email metadata (To, From, Sent, Subject, etc.) to 
similarly named SharePoint columns. 

The .msg format maintains fidelity of the message, including attachments. A unique SharePoint file 
name is generated based on Sender, Sent, and, Subject.  
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Dragging from Desktop to Outlook  

You can upload files to SharePoint by dragging-and-dropping directly from your Desktop (or My 
Computer) into the Outlook folder tree. Contributor prompts for metadata, and uploads the file to the 
selected library.  

 

Dragging Email Attachments into Outlook 

You can upload attachments to SharePoint by dragging-and-dropping directly from an email into the 
Outlook folder tree. Contributor prompts for metadata and uploads the file to the selected library.  
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Using Send and File 

You can automatically store copies of sent mail using the Send & File command in the Colligo Send & 
File toolbar. 

You can select the destination SharePoint location using the Colligo for SharePoint folders in the Outlook 
folder tree. The Filing Advisor suggests locations based on recently used folders or email conversations.  

Contributor automatically extracts email metadata (To, From, Sent, Subject, etc.) to similarly named 
SharePoint columns.  

The .msg format maintains fidelity of the message, including attachments. A unique SharePoint file 
name is generated based on Sender, Sent, and, Subject.  

 

Using the Copy Folder 

Folders, and their contents (including subfolders), from your mailbox can be uploaded to SharePoint 
using the Copy folder command in the Colligo toolbar. A corresponding folder tree is created in 
SharePoint and the individual emails are uploaded.  

Contributor automatically extracts email metadata (To, From, Sent, Subject, etc) to similarly named 
SharePoint columns. 

The .msg format maintains fidelity of the message, including attachments. A unique SharePoint file 
name is generated based on Sender, Sent, and, Subject.  
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DEFAULT METADATA AND PROMPTING BEHAVIOR 

Contributor allows you to specify default values for metadata. Default values can be set at a document 
library, or subfolder level. The default values support both inheritance and propagation.  

Introducing the Metadata Dialog 

A sample of the Default Metadata Values dialog is displayed below. The following table explains the 
function of the dialog. 

 

List Selector Panel 

 

The List Selector allows you to change the List or Subfolder you wish to work with. 

NOTE: The List selector is only visible if the dialog is access through the File menu. 

Default Value 
Settings 

 

Name The Display Name of the SharePoint column 

Value The default value to be applied. 

Inherited From Indicates where Contributor receives this value from. The ‘Inherit 
From’ column may take the following values: 

 SharePoint Column definition 

 <not inherited> 
Parent Object Name. This may be the name of a document library of 
parent folder. 

Apply To Indicates whether the default value may be inherited by a subfolder. 
The ‘Apply To’ folder may take the following values: 

 This Folder and subfolders 

 This Folder only 

Add, Edit and 
Remove 

 

This buttons allow you to work with the locally-defined default values.  

Multiple items can be selected for removal using the Windows standard Ctrl and Shift 
selection modifiers. 

Inherit propagating 
values from parent 
items 

This folder will inherit propagating values from the parent item. Values specified with ‘This 
Folder and subfolders’ are propagating values and may be inherited.When un-checking 
the option Contributor provides the option to copy inherited values locally. 

 

 

 

1. List Selector Panel 
2. Default Value Settings 
3. Add, Edit and Remove 
4. Inherit propagating values from 

parent items 
5. Clear locally-defined values on all 

child items 
6. Prompting Behavior 

5 

4 

3 

6 

2 1 
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Clear locally-defined 
values on all child 
items 

When settings are applied with this values checked, child-items are reset to inherit values; 
any user-specified default values on child-items are cleared. 

Prompting Behavior 

 

Modify the prompting behavior. The options are: 

 Always: The metadata prompt will be displayed when an item is added 

 Never: The metadata prompt will *not* be displayed when an item is added 

 According to application global settings: Prompting behavior is as defined in the 
View-> Options dialog 

Child-items that are configured for inheritance will inherit this setting. 

Accessing the Dialog 

File Menu 

The file menu may offer different options depending on which elements of Contributor are deployed. 
The Contributor Control Panel interface may be accessed by double-clicking the Contributor icon in the 
system tray. 

 

Control Panel 

* When accessed through the File menu, the Default Metadata dialog includes the List Selector 
Panel 
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CONFIGURATION 

Contributor provides easy access to the common configuration options. 

Prompt for properties when adding documents 

By default, Contributor prompts for metadata when content is added. You can disable this prompt. If the 

prompt is disabled, content is uploaded to SharePoint with default metadata. 

Use current Windows appearance 

You can switch Contributor’s user interface between a Windows application look-and-feel and a WSSv3 

style look-and-feel. With the Windows appearance, Contributor adopts the underlying Windows color 

scheme. 

Storage location 

You are able to move the Contributor cache to another location.  

Automatically downloads lists to resolve Site Column values 

Contributor ensures that data for Lookup columns is also synchronized. 


